[bookmark: _GoBack]Name:  Kelsey Lovell

Date and Time that the Lesson will be Taught:  January 20th-January 28th (1st, 3rd, 5th, 6th, and 7th Period)

Lesson Title:  Microsoft Word Basics and Basic Editing (Word Lessons 1 and 2)

Name of Class:  Computer Applications I (8th Grade)

Curriculum Framework Unit and Item:

	Unit 2:  Word Processing—Creating Simple Documents
	2.1 Define terminology
	2.2 Explain word wrap
2.3 Explain the commonly used keys to delete text
2.4 Explain the insert key
2.10 List reasons for proofreading
2.12 Define terminology when using file management
2.14 Explain the purpose of print preview

Unit 3:  Word Processing—Changing Margins, Formatting Paragraphs, and Setting and Using Tabs
3.4 Describe paragraph spacing

Unit 4:  Word Processing—Moving, Copying, and Revising Text
4.1 Define terminology
4.2 Explain cut and paste
4.3 Explain copy and paste
4.5 Describe find and replace
4.6 Describe the advantages of find and replace to edit a document
4.7 Identify the clipboard

Objectives:  The learners will be able to…..

	Lesson 1
1. Start Word and understand the ways to view your document
2. Enter text in a document and navigate a document
3. Use Backspace and Delete to correct errors
4. Save a document
5. Open an existing document
6. Use Full Screen Reading view
7. Change the page orientation of a document. Preview and print a document
8. Exit Word

Lesson 2
9. Show and hide formatting marks
10. Select text
11. Create paragraphs without blank space between them
12. Undo, redo, and repeat recent actions
13. Move and copy text using drag-and-drop and the Clipboard
14. Use the Office Clipboard
15. Find and replace text, and use the Go To command
16. Identify the number of words in a document or a selection



Content to be Presented in Lesson:

· Terminology (Lesson 1)
a. Word Processing-the use of computer software to enter and edit text
b. View Buttons-buttons at the bottom-right of the document window, to the left of the zoom slider, that switches the document views
c. Insertion Point-where the text appears in the document window; moves to the right as you type
d. Word Wrap-words are “wrapped around” to the next line when they do not fit on the current line
e. Quick Access Toolbar-located at the top of the screen next to the Office button; allows you to quickly access common commands
f. Zoom-magnifies and reduces your document on the screen; measured in percentages
g. Full Screen Reading View Toolbar-removes the Ribbon and the status bar from the screen
h. Portrait Orientation-Longer than they are wide
i. Landscape Orientation-Wider than they are long

· Tasks (Lesson 1)
a. Starting Word
b. Inserting Text and Understanding Word Wrap
c. Navigating a Document
d. Using Backspace and Delete
e. Saving a Document
i. Creating Folders
f. Locating and Opening an Existing Document
i. Opening a New, Blank Document
g. Zooming a Document
h. Switching to Full Screen Reading View
i. Selecting a Page Orientation
j. Previewing and Printing a Document
k. Exiting Word

· Terminology (Lesson 2)
a. Toggle-switching between two options (or features) by turning it off or on
b. Select-highlight a block of text
c. Drag-holding the left button on the mouse, drag the pointer to the end of the text you want to select, and release the button
d. Format-to change its appearance
e. Drag-and-Drop-positioning the pointer on top of the selected text, and dragging the selected text to a new location
f. Clipboard-temporary storage place in the computer’s memory
g. Cut-removing selected text from the document and placing in on the Clipboard
h. Copy-selected text remains in the document and is copied to the Clipboard
i. Paste-placing text from the Clipboard into the document
j. Office Clipboard-special clipboard on which you can collect up to 24 selections




· Tasks (Lesson 2)
a. Editing Text
b. Showing Formatting Marks
c. Understanding Toggle Commands
d. Selecting Text
e. Creating Paragraphs Without Blank Space Between Them
f. Using the Undo, Redo, and Repeat Commands
g. Using Drag-and-Drop to Move and Copy Text
h. Using the Clipboard to Move and Copy Text
i. Cutting and Pasting to Move Text
ii. Copying and Pasting Text
iii. Using the Paste Options Button
i. Using the Office Clipboard
j. Using the Find and Replace Commands
i. Finding Text with the Navigation Pane
ii. Replacing Text
k. Using the Go To Command
l. Identifying the Number of Words in a Document or Selection


References:


Arkansas State Department of Education 		Curriculum Frameworks

Introductory Microsoft Office 2010 Textbook

Materials and equipment needed for lesson:

Computer—Projector—Screen—Microsoft Word—Computers for Students—Printer 


MONDAY, JANUARY 20, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and turn your monitor off when you are done. Wait for students to finish current tab and turn off monitors. Today we are going outside for a physical activity period.

Learning Activities:								Time:	39-42 minutes	

Take class outside to walk the track/exercise for the period.

TUESDAY, JANUARY 21, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and turn your monitor off when you are done. Wait for students to finish current tab and turn off monitors. Today we are going to begin working on the Microsoft Word Lesson 1. You have been working in Word so far while keying your two-column notes. Today, we are going to review the key terminology and tasks associated with this lesson.

Learning Activities:								Time:	39-42 minutes	

Demonstration								Time: 7-9 minutes

Word processing is the use of computer software to enter and edit text. The word processing software that we will be using in this class is Microsoft Word. In Word, you can easily create and edit documents to use in your school, career, personal, and business activities. To start Word, click All Programs on the Start Menu, then click Microsoft Office on the submenu, then click Microsoft Word 2010. 

Microsoft Word contains many elements. Point to each element as they are described. The ribbon contains commands for working with the document. These are organized by tabs. The quick access toolbar, located above the ribbon, contains buttons for common commands. The insertion point shows where text will appear when you begin typing in the work area. The insertion point moves to the right as you type. The status bar, at the bottom of the program window, displays information about the current document and process. The view buttons located on the status bar allows you to change views quickly. The zoom slider, also located on the status bar, allows you to increase or decrease the size of the document on-screen.

There are several views in Microsoft Word, of which you can switch with the view buttons on the status bar. Print layout view shows how a document will look when it is printed. Full screen reading view will show the text on the screen in a format that is easy to read and hides the Ribbon. Web layout view simulates the way a document will look when it is viewed as a Web page. Outline view displays heading and text in outline form so you can see the structure of your document and reorganize easily. Finally, the draft view displays only the text of a document without showing the arrangement of the text; it also does not show any pictures.

If the test you are typing extends beyond the right margin, it automatically moves to the next line. This feature is called word wrap. When you press Enter, a blank line is inserted automatically and you begin a new paragraph. 

There are several ways to navigate through a document. You are able to utilize your arrow keys, page up and down, and the home and end keys to move your insertion point. If you make a mistake while typing or just want to change the text, you may delete the characters using the backspace and delete keys. The backspace key removes text to the left of the insertion point; whereas the delete key removes text to the right of the insertion point. 

While working in Windows, Networks, and Computer Basics, we completed how to save files, create folders, and create new, blank documents. Does anyone still have a question about how to complete any of these tasks? Wait for students to confirm they do not have any questions. 

The zoom feature can be used to magnify and reduce your document on the screen. Zoom is measured in percentages. To change the zoom, you can utilize the zoom slider as we discussed earlier. Another method to zoom a document is to use the Zoom group in the View tab.

Microsoft Word has two ways to print text on a page:  portrait and landscape. Portrait orientation documents are longer than they are wide. In contrast, landscape orientation documents are wider than they are long. A majority of documents are printed in portrait orientation. To change the orientation of the document, click the Page Layout tab and choose the orientation from the Orientation button in the Page Setup group. To preview your document before printing, click File, then click Print, and preview your document on the right of the window. The print options will be on the left. Are there any questions so far about Microsoft Word? Answer any questions from students.

Independent Work								Time: 30-35 minutes

Class, once you have finished your Windows, Networks, and Computer Basics unit, begin working on your assignments for this lesson. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips). 

Summary of information in the lesson:					Time:	1-2 minutes

Today, we began to review the basics of Microsoft Word. We identified the elements of Microsoft Word and reviewed how to navigate through the program and different views. We also discussed how to zoom in to magnify and reduce your document on the screen. Finally, we learned the different print orientations and how to change them in Microsoft Word.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.



WEDNESDAY, JANUARY 22, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and turn your monitor off when you are done. Wait for students to finish current tab and turn off monitors. Today we are going to begin working on the Microsoft Word Lesson 2. We are going to continue to work with Microsoft Word by learning basic editing in the program.

Learning Activities:								Time:	40-44 minutes	

Demonstration								Time: 7-9 minutes

As we discussed yesterday, Microsoft Word is a word processing software. Demonstrate each item as they are discussed. In this program, we are able to edit our text and documents. On useful feature of Microsoft Word is the show/hide command. This command allows you to view the formatting marks in your document. The show/hide command is an example of a toggle command. A toggle can be turned on and off. Can anyone give me an example of another toggle command? Wait for student to answer. Another example of a toggle command is the bold function.

While editing text, we will need to be able to select the desired text. To select text means to highlight a block of text. To select text with the mouse, hold the left button on the mouse while you drag the pointer to the end of the text you want to select and release the button. This is called dragging. Another method that could be used to select a word is to double-click on the word. To select a line, you can position the pointer in the left margin on the desired line to select and click.

While creating documents, you will be required to format the text or paragraphs, or change the appearance of the text or paragraphs. In Microsoft Word, its default setting includes space after each paragraph. You will have to format the paragraph to remove the space.

Microsoft Word also includes features that allows you to undo, redo, and repeat commands. The undo button reverses a recent action. The redo button reverses an undo action. Finally, the repeat button repeats the most recent action.

Now we will begin discussing how to move and copy text. One method that can be used is the drag-and-drop method. First you select the text you wish to move. Then, you drag is to the desired location in the document. If you want to copy the text instead of move it, you must press and hold the Ctrl key while you drag it. Another method to move and copy text is using the clipboard. The clipboard is a temporary storage place in the computer’s memory. You can either cut, removing the selected text from the document, or copy, selected text remains in the document, selected text to the clipboard. When you chose to paste the text, you can chose from a list of paste options. If you would like to collect up to 24 selections, you would utilize the Office Clipboard that is unique to Microsoft Office programs.

Sometimes while working in a document, we will need to find certain sections or words. This can be done by accessing the find command. We could also utilize the replace command. This allows us to replace all words in a document with another word without having to search for them. Both of these commands are located in the Editing group on the Home tab. The Go To command works in a similar way. On the Home tab, in the Editing group, click the arrow next to the Find button, and then click Go To on the menu. This will allow you to jump to a desired section of your document.

The final function in this lesson that we will focus on is the word count command. As you type and edit your documents, you may want to know how many words it contains (maybe for an English paper). The word count appears in the bottom right corner of the status bar in the window. You can also access the word count by clicking on the word count button in the Review tab.

Independent Work								Time: 30-35 minutes

Class, please continue to work on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).  Students will work on the following assignments for Word Lesson 2:  Lesson 2 Two-Column Notes, Step-by-Step 2.1-2.10, Word 2 Review PowerPoint, Whooping Crane Proofreading Assignment, Project 2-3 (Web Site Tips), Project 2-4 (Tournament Notice), and Project 2-5 (Interview Preparation). Students will also complete the ExamView Word Lessons 1 and 2 Multiple Choice Test and the SAM Test.

Summary of information in the lesson:					Time:	1-2 minutes

Class, today we worked through some basic editing functions in Microsoft Word. We discussed what a toggle command is as well as created some examples. We also reviewed how to move and copy text using the drag-and-drop method as well as the clipboard. Finally, I demonstrated how to utilize the navigation pane (find, replace, and go to) and how to identify the number of words in a document or selection.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.

THURSDAY, JANUARY 23, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and continue working on your assignments.

Learning Activities:								Time:	40-44 minutes	

Independent Work								Time: 40-44 minutes

Please continue working on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.




FRIDAY, JANUARY 24, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and continue working on your assignments.

Learning Activities:								Time:	40-44 minutes	

Independent Work								Time: 40-44 minutes

Please continue working on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).  Students will work on the following assignments for Word Lesson 2:  Lesson 2 Two-Column Notes, Step-by-Step 2.1-2.10, Word 2 Review PowerPoint, Whooping Crane Proofreading Assignment, Project 2-3 (Web Site Tips), Project 2-4 (Tournament Notice), and Project 2-5 (Interview Preparation). Students will also complete the ExamView Word Lessons 1 and 2 Multiple Choice Test and the SAM Test.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.

SATURDAY, JANUARY 25, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and continue working on your assignments.

Learning Activities:								Time:	40-44 minutes	

Independent Work								Time: 40-44 minutes

Please continue working on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).  Students will work on the following assignments for Word Lesson 2:  Lesson 2 Two-Column Notes, Step-by-Step 2.1-2.10, Word 2 Review PowerPoint, Whooping Crane Proofreading Assignment, Project 2-3 (Web Site Tips), Project 2-4 (Tournament Notice), and Project 2-5 (Interview Preparation). Students will also complete the ExamView Word Lessons 1 and 2 Multiple Choice Test and the SAM Test.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.


MONDAY, JANUARY 27, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and continue working on your assignments.

Learning Activities:								Time:	40-44 minutes	

Independent Work								Time: 40-44 minutes

Please continue working on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).  Students will work on the following assignments for Word Lesson 2:  Lesson 2 Two-Column Notes, Step-by-Step 2.1-2.10, Word 2 Review PowerPoint, Whooping Crane Proofreading Assignment, Project 2-3 (Web Site Tips), Project 2-4 (Tournament Notice), and Project 2-5 (Interview Preparation). Students will also complete the ExamView Word Lessons 1 and 2 Multiple Choice Test and the SAM Test.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.

TUESDAY, JANUARY 28, 2014

Introduction to the Lesson:							Time:  5-7 minutes

Good morning/afternoon class! Please begin the working in Microtype. Give students 5 minutes to work in Microtype. Please start looking for a place to stop and continue working on your assignments.

Learning Activities:								Time:	40-44 minutes	

Independent Work								Time: 40-44 minutes

Please continue working on your assignments. Students will work on the following assignments for Word Lesson 1:  Lesson 1-1 Two-Column Notes, Step-by-Steps 1.1-1.5, Word 1-1 Review PowerPoint, Lesson 1-2 Two-Column Notes, Step-by-Step 1.6-1.10, Word 1-2 Review PowerPoint, Project 1-3 (Thank You Letter), Project 1-4 (Holiday Sale Flyer), and Project 1-5 (Interview Tips).  Students will work on the following assignments for Word Lesson 2:  Lesson 2 Two-Column Notes, Step-by-Step 2.1-2.10, Word 2 Review PowerPoint, Whooping Crane Proofreading Assignment, Project 2-3 (Web Site Tips), Project 2-4 (Tournament Notice), and Project 2-5 (Interview Preparation). Students will also complete the ExamView Word Lessons 1 and 2 Multiple Choice Test and the SAM Test.

Evaluation/assessment of student learning:	

The students will be informally evaluated on their understanding of Microsoft Word through observations of the students’ work throughout the class period. The students will be formally evaluated on their knowledge and ability to use Microsoft Word through the use of comprehensive projects, a multiple choice test, and a production test.

